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Using DAC with WinCvs

INFO:

This technical note
only provides infor-
mation on how to
configure DAC to
facilitate your work
with the WinCvs 1.2,
for which the docu-
ment has primarily
been written. Using it
as a basis, DAC can
easily be configured
to work with a later
version of WinCvs.
The description of
the processes of
installing, configuring
and using WinCvs
version 1.2 is
beyond the scope of
this document. If you
would like to know
something more
about these things,
please consult
WinCvs user docu-
mentation.

For further informa-
tion on DAC, please
refer to "Develop-
ment Assistant for C"
documentation V4.0.

I Requirements
]

DAC - V4.0.058 or later - (Development Assistant for C -
RistanCASE). The latest version, with Demo Mode license included,

can be downloaded from the following URL:
http://www.RistanCASE.com/dac/v40/dac_download.php

If you are running DAC in Demo Mode, you can easily obtain a trial
license and enjoy all the comforts of DAC for two weeks! For more
details, choose Technical Support from the Help menu.

WinCvs 1.2 or later (CvsGui.org)- You can download WinCvs ver-
sion 1.2 from our site: http://www.ristancase.com/anonftp/pub/gnu/
WinCvs120.zip or you can download the latest version, from the fol-
lowing URL: http://www.wincvs.org/download.html

Created WinCVS repository.

DAC project files put under WinCVS control.

DAC-40-71-121
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NOTE:

DAC WinCvs sup-
port applies only to
files in the DAC
project.

2 Configuring DAC
]

For WinCys features to be available from DAC, you have to open the
project in DAC in which you want to use WinCvs features and adjust
WinCvs support.

After this procedure, DAC is configured and ready to assist you in your
work with WinCyvs.

2.1 Version Control System Options

On the Options menu, click Version Control System to open the Version
Control System Options dialog box.

¥ersion Control System Options ﬂ E k

Wergion Contral System | Connectionl Project Dependentl About Plug-ln I

Help |

Ok, I Cancel | Help

Figure 2.1 Selecting an external VCS system

©2002 RistanCASE GmbH DAC-40-71-121
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From the System list choose the "WinCvs 1.2". Some additional tabs will
appear in the dialog box: Connection, Project Dependent and About
Plug-In.

2.1.1 Connection
In this tab, you set the the location of the "wincvs.exe" file. (By default:
"C:\Program Files\GNU\WinCvs 1.2\wincvs.exe")

Yersion Control System Options ﬂ E L

“ergion Contral System  Connection | Project Dependentl About Plug-In I

WinCys [Wincws.exe)
IC:\Program FileshGMUYWINCws 1. 2hwincwvs exe Browsze... |

: : Cancel | Help |
S

Figure 2.2 Setting the parameters for connecting DAC and WinCvs

WinCvs (wincvs.exe)

Enter the location of the "wincvs.exe" file.

DAC-40-71-121
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2.1.2 Project Dependent

In this tab, you set the arguments of certain WinCV'S commands.

¥ersion Control System Options B E L

“Werzion Control Systeml Connection  Project Dependent |.t’-‘«b0ut F'Iug-lnl

UsemamelJane CWSROOT ID:\F!istanCASE\Master

—ersion labels———— [~ Following DAL project state—

Ref tial IHEF_VEH
SietEma * Marual

¥ Force development kag
Tag IJN_\-"EF!

— Checkout options—————— — Output options
Jv Show output dialog
I Autarclose

= Automatic with prompt

| Checkout read-only

— Difference report option
I~ lgnore leading and trailing white spaces  Contest lines IEI

Cancel | Help |

Figure 2.3 Setting WinCVS commands arguments

Username

The user name under which you are logged on Windows. That is also the
name under which you work in WinCvs.

CVSROOT

The location of the repository defined in WinCyvs.

Version labels

Referential
Tag or number of the revision in relation to which differences will be
displayed.

Force development tag
Defines that on the Commit selection command, a tag is set on a new
revision.

Tag

Tag you want to set on the revision after the Commit selection com-
mand.

Following DAC project state

Defines whether the file being added to the DAC project will automati-
cally be added to the WinCVS repository.

©2002 RistanCASE GmbH DAC-40-71-121
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Manual
A new file of the DAC project must be added to the WinCVSS reposi-

tory manually.
Automatic with prompt
A new file of the DAC project is added to the WinCVSS repository

automatically with a prompt.

Checkout option

Checkout read-only
After the Commit selection command (and the checkout command
executed from WinCvs) the file status will be read-only.

Output options

Show Output dialog
While a WinCV'S command is being carried out, the CVS Command
Output dialog box is displayed.

Auto-close
The dialog box is automatically closed when the command has been

carried out.

Difference report options

Ignore leading and trailing white spaces
Versions differing only in white spaces (space, TAB) will be consid-
ered identical.

Context lines

Number of lines in the report on differences before and after the line
that is different in the versions compared.

DAC-40-71-121
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3 Using WinCvs features
from DAC
I

After you have activated WinCvs support, the following is available to
you in DAC:

e The Version Control System menu, The Version Control toolbar and
two additional commands of the Project window shortcut menu,

» The display of the status of files under WinCVS control (hereafter:
WinCVS status) via the Project window Logical view (/G ).

3.1 The Version Control System menu

Commit selection...
Update selection. .
Edit zelection
Unedit selection

Add selection...

Log zelection
Diff selection

WinCys
T

Figure 3.1 The Version Control System menu

* Commit selection - forms a new revision in the repository,

+ Update selection - updates the working copy of a selection on the
basis of the revision in the repository,

» Edit selection - prepares the selection for editing,

* Unedit selection - the end of changes to a selection,

©2002 RistanCASE GmbH DAC-40-71-121
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* Add selection - adds files within the selection to a WinCVS project,
* Log selection - displays the history of changes to a selection,

* Diff selection - displays the differences between the working copy of
a selection and the revision in the repository,

*  WinClyvs - starts the WinCvs environment.

3.2 The Shortcut menu

The commands Commit selection and Edit selection are part of the
Project window shortcut menu.

3.3 The Version Control toolbar

WinCvs commands are also available on the Version Control toolbar.
The toolbar appears automatically after the WinCvs support has been
adjusted.

mEszEE e &

Figure 3.2 The Version Control toolbar

#17 - Commit selection

] - Update selection
& - Edit selection

&# - Unedit selection

[*] - Add selection
- Log selection
& - Diff selection

B - WinCvs

3.4 WinCvs commands available in DAC

WinCvs commands can be carried out on a selection in the Logical view
('@ ] or Folder view ('@ |) of the Project window or on a file open in
the Editor.

DAC-40-71-121
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If you want to follow the process of a WinCvs command execution, select
the Show Output dialog in the Project Dependent tab of the Version
Control System Options dialog box. If you want to stop the command
being carried out, use the Stop button.

C¥S Command Dutput L

— Command O utput

o3 -q update -+ JN_YERSION Testl.c

cvz [update aborted]: no such tag JN_VERSION

ok | s
—

Figure 3.3 Report on the execution of a WinCVS command

If any question is posed during the execution of the WinCV'S command,
additional buttons, Yes and No, appear in the dialog box enabling you to
respond to the question:

CV¥S5 Command Dutput L

— Command Dutput

cvs -q unedit Test].c

Testl.c has been maodified; revert changes?

ez | Mo I [k | Stop |
T —

Figure 3.4 Report during the question posed

3.4.1 Commit selection

This command corresponds to the WinCvs Commit selection command
which you use to create a new file revision in the repository. If you want
to set the appropriate tag on the new revision, in the Project Dependent
tab of the Version Control System Options dialog box, select Force
development tag and enter the desired Tag. Figure 2-2 shows the dialog
box in which you enter revision comments.

-8- ©2002 RistanCASE GmbH DAC-40-71-121
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Revigion comment L
Filetame: Testl.c oK |
Rievision comment: Cancel |
I [~

¥
A L

I~ FRevizion comment iz the same for all selected files

Figure 3.5 Dialog box for entering comments on the Commit selection command

If you want the comment to be the same for all files within the selection,
select Revision comment is the same for all selected files.

3.4.2 Update selection

This command corresponds to the WinCvs Update selection command
which you use to update the working copy of a file on the basis of a revi-
sion from the repository. You can assign the necessary parameters of this
command:

Update Settings - Dnc.c E L
™ Reset amy sticky date/tags k' option
Sticky Option:
™ Before date: I

IV Retrigve rev. /tag/branch: IJN_VEHS|UN

™ Settings are the same for all selected files

ok I Cancel |

Figure 3.6 Setting the Update selection command options

Reset any sticky date/tag/’-k’ option

Resets the sticky dates or tags set. If none of the Sticky Options is
selected, the working copy of a file is updated on the basis of the last revi-
sion in the repository.

Sticky Options
The date and number or tag of the revision with which the working copy

of a file is synchronized.

Settings are the same for all selected files

The set options apply to all files within the selection.

DAC-40-71-121
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NOTE:

The command can
be carried out only
on files in a direc-
tory that is already
under WinCVS con-
trol.

3.4.3 Edit selection

This command corresponds to the WinCvs Edit selection command
which you use to notify all users who have set the watch flag on a file, that
you intend to edit the file.

3.4.4 Unedit selection

This command corresponds to the WinCvs Unedit selection command
which you use to notify other users that you have finished changing the
file or that you have decided to cancel these changes.

3.4.5 Add selection

This command corresponds to the WinCvs Add selection command
which you use to add the selected file to the WinCVS repository.

|

File description

Filetame: Testl.c ak |

File description: Cancel

[ |

¥
4 k

I Description iz the same for all selected files

Figure 3.7 Entering the file description on the command Add selection

Description is the same for all selected files

If this option is selected then the comment applies to all selected files.

If the file that is being added is a binary one, a dialog box will appear with
a question whether you want to add the file as a binary or a textual one.

N |

File " 22.0bj" zeems to be 'binary'.
Do wou want add him binary ["-kb" option]?

Yes No | LCancel |

Figure 3.8 Dialog box displayed during adding a binary file

If you want the file being added to the DAC project to be added to the
WinCVS repository as well, select Automatic with prompt in the Project
Dependent tab of the Version Control System Options dialog box.

-10 -
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3.4.6 Log selection

This command corresponds to the WinCvs Log selection command which
is used to display the history of file changes in the DAC Editor.

If the file in which the revision history is to be shown already exists, a dia-
log box will appear with the question whether the new report is to be
added at the end of the existing one or a new one is to be created.

DAC | ] L

Append report ta existing file:
D:4RistanCAS ENwWorkingDirtD1 for
CwWShproj24Progprevh Test2 hat

Ho | LCancel |

Figure 3.9 Dialog box which appears if the file already exists

3.4.7 Diff selection

This command corresponds to the WinCvs Diff selection command which
displays in the DAC Editor the differences between the working copy of a
file and the revision in the repository. In the Project Dependent tab of the
Version Control System Options dialog box, enter the Referential revi-
sion with which the working copy of a file will be compared. If you do not
enter the referent revision, the last revision in the repository will be used.

3.4.8 WinCvs

This command starts WinCvs environment, while the location of the
WinCvs browser ("View / Browse Location / Change") is identical to the
location of the DAC project root entered in the Project root directory
box in the Directories tab of the Project Options dialog box.

3.5 The WinCVS status display

The icon in front of the file in the Project window Logical view (/G |)
reflects the file WinCVS status:

Icons next to the files in the Project window Logical view
Icon Explanation

& (blue key) Indicates that the file is in the WinCVS repos-
itory and that it is editable

B (red key) Indicates that the file is in the WinCVS repos-
itory but that it is not editable

DAC-40-71-121
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Icons next to the files in the Project window Logical view (Continued)

Icon

Other icons

Explanation

Other icons mark files that are not in the
WinCVS repository. For more information
please, see Logical View chapter in the Refer-
ence Manual of the DAC Documentation.

You can find more detailed information in the Version Info tab of the
detailed pane of the Project window Logical view:

File state displayed in the Version info tab the Project window Logical view

File state

Status (file status)

Lockers
(only if the file status
is Editable)

Version Labels
(only if the file is in
the WinCVS project)

Explanation

WinCVS status of the project file can be:
- Not in, VCS

- Not Editable

- Editable

User name under which you have carried out
the Edit command on a file

Revision sticky tag or, if there is no tag, revi-
sion number.

-12 -
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INFO:

You can find more
about the Documen-
tation Generator in
DAC Documenta-
tion (Documentation
Generator chapter in
the User Manual).

4 Including WInCVS reports
in the documentation

You can include the following WinCVS information in the documentation
generated by the Documentation Generator (DG).

Available WinCVS information for the Documentation Generator

WinCVS
information

VCSHistory

VCSDifference

VCS Data

Explanation

History of changes to a file (the output of the
Log selection command)

Differences between the working copy of a
file and the revision in the repository (the out-
put of the Diff selection command)

WinCVS information on the project (referent
file version, tag set on a new revision) or file
(date and time of the last change in a file,
WinCVS status of the file, user name under
which you have carried out the Edit command
on the file, and the Sticky tag or revision num-
ber).

Possible errors in generating VCSHistory and VCSDifference informa-
tion are given in Documentation Generator warnings of WinCvs support.

DAC-40-71-121
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NOTE:

You can find more
about the DG warn-
ings in DAC Docu-
mentation (Chapter

Documentation Gen-

erator in the Refer-
ence Manual)

5 Documentation Generator
warnings of WinCvs support
L

DG warnings for unsuccessful generation of VCSHistory and VCSDif-
ference information:

DG warnings of WinCvs support
DG warnings Explanation

WinCvs hasnotbeen  WinCvs has not installed properly, so DAC
installed properly! cannot read the needed data from the Win-
dows registry

CVS: Nothing CVS control does not have any information on

known about [...] the file [...]

Cannot open output  The error while opening the temporary file in

file which the output of the Log or Diff command
is stored

CVS command Problem during carrying out the Log or Diff

stopped or failed command.

-14 -
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]
6 Design limitations
]

In the Version Info tab in the lower pane of the Project window Logical
view, not all users who have carried out the Edit selection command on
the selected file are displayed. This would require access to the repository,
which might last for a long time and would considerably slow down DAC
functioning.

The other limitation is that in the current Plug-In version, only the local
work mode is supported (the repository and the working directory are
stored locally). It is planned that the following Plug-In versions support
network mode as well.

DAC-40-71-121 ©2002 RistanCASE GmbH -15-
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7 Troubleshooting

Possible problems and ways to overcome them

Problem

Answer

The icon for the WinCyvs 1.2 sys-
tem in the Version Control System
tab of the Version Control Sys-
tem Options dialog box is red.

(%)

On trying to confirm the Version
Control System Options dialog
box, the message is displayed:
Cannot save configuration

On trying to confirm the Version
Control System Options dialog
box, the message is displayed:
Cannot load "cvs2ntlib.dll""

The WinCvs Plug-In version does
not correspond to the DAC ver-
sion. If you select WinCvs 1.2 and
click the OK button, the informa-
tion on the existing and the
expected version will appear. To
obtain the correct version, please
contact your supplier.

You have probably added the DAC
project (*.dcp) file to the WinCV'S
repository, or it has been marked
as read-only in some other way.
You will solve this problem by
removing the read-only attribute.

Check whether you have entered
the correct location of the
"wincvs.exe" file in the Version
Control System Options dialog
box, Connection tab.

©2002 RistanCASE GmbH
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Possible problems and ways to overcome them (Continued)

Problem

Answer

The CVSROOT location in the
Project Dependent tab of the Ver-
sion Control System Options dia-
log box does not correspond to the
real location of the repository of
your project files.

The information in the Project
window Logical view (/4 |) on
the status of the file under
WinCVS control is incorrect.

A problem appears while WinCvs
Plug-In is being configured, and
you cannot turn on transaction log-

ging because the VCS Support
INI File command is not available
on the Configuration Files sub-
menu, on the File menu.

While working on the net, a prob-
lem appears concerning data inter-
ference in the VCS Support INI
file.

You have changed the location of
the repository in WinCvs (Admin /
Preferences / General / Enter the
CVSROOT) and DAC has read
that data. However, there is no
need to worry, WinCvs support
will function correctly because
WinCvs commands provided by
this Plug-In use the CVSROOT
adjustment saved in local
"WinCVS" directories.

You have probably carried out
some WinCVS command outside
DAC, so that DAC does not have
the latest information on the status
of the file under WinCVS control.
On the Project menu, click
Refresh Project Window to
gather the valid information and
update the information on the sta-
tus in the Project window Logical
view.

The command VCS Support INI
File becomes available only after
you have configured WinCvs sup-
port. The VCS Support INI file in
which you adjust transaction log-
ging ("VpWinCvs12.ini") can be
found in the directory in which the
DAC project file resides (file with
".dcp" extension) or in the DAC
install directory. Open it in any
editor and turn on transaction log-
ging. (see Technical support)

Create the "VpWinCvs12.ini" file
in the directory in which the DAC
project file resides (file with

".dcp" extension), and again con-
figure WinCvs support. The data
will be stored in the newly formed
file.

DAC-40-71-121
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8 Technical support
]

In case of problems in working with WinCvs support, the best way is to:

* Activate transaction logging:
Transaction logging is activated in the following way:

@ On the File menu, point to Configuration Files, and then
click VCS Support INI File to open the appropriate INI
file.

 In the section:
[ vpwi ncvs12.dl ]
for the keyword VCSLog assign the file name (for example:
"VCSLog=D:\Temp\WinCvs12.log"). If the absolute path is

not specified in the file name, the file will be created in the
place where the appropriate project file is.

a If you want the log to come after the previously created one,
for the keyword VCSLogAppend assign "Yes" (for example:
"VCSLogAppend=Yes").

[ Close and then open your DAC project.
» Repeat the operation during which the problem appeared,

*  On the Help menu, click Technical Support to open the DAC Tech-
nical Support and send the appropriate log, along with the descrip-
tion of the problem to the support address shown on the License Data
tab.

-18 - ©2002 RistanCASE GmbH DAC-40-71-121
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